
Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Táto „Príručka“ je určená pre tých, ktorí požiadali o licenciu na doplnkovú službu pre digitálny fotoaparát Sony.
Funkcie zahrnuté do „Volume Photography License Package“ (Licenčný balík pre hromadné fotografovanie) sú
vysvetlené tu.
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Prehľad funkcií

Uvádza možnosti, ktoré môžete použiť v rámci licencie pre hromadné fotografovanie.

Prehľad funkcie

Aktivácia každej licencovanej funkcie

Používateľská pomocná mriežka

Snímanie a značenie

Nasnímanie a zaregistrovanie čiarového kódu alebo QR kódu pomocou fotoaparátu

Zobrazenie jedinečných identifikátorov na obrazovke

Kontrola informácií o jedinečnom identifikátore

Vymazanie jedinečného identifikátora z fotoaparátu

Photo Cropping

Volume Photography Commands
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Prehľad funkcie

Služba hromadného fotografovania poskytuje vybavenie a nástroje, ktoré možno využiť v prostrediach, kde je potrebné
zhotovovať veľké množstvo fotografií v rovnakom formáte a s rovnakými postupmi, ako napríklad v školách, pri
športových podujatiach, v zábavných parkoch alebo na výletných lodiach.
Tieto funkcie pomáhajú znížiť rozdiely v kvalite fotografií spôsobené úrovňou zručnosti alebo skúsenosťami jednotlivých
fotografov a umožňujú efektívny pracovný postup od prípravy na snímanie až po orezávanie fotografií.

Používateľská pomocná mriežka
Zaregistrovať a používať môžete svoju vlastnú používateľskú pomocnú mriežku vytvorenú tak, aby vyhovovala vašim
konkrétnym potrebám vo fotoaparáte. „Custom Gridline Generator“ umožňuje nastaviť oblasti orezania na pomocnej
mriežke a priamo zaregistrovať vytvorenú pomocnú mriežku vo fotoaparáte.

Scan and Tag
Celý proces od nasnímania jedinečného identifikátora až po prepojenie zachytenej fotografie s jedinečným
identifikátorom je možné vykonať len jediným fotoaparátom.

Photo Cropping
Nastavením oblasti orezania môžete pri snímaní súčasne uložiť pôvodný záber aj orezaný záber.

Volume Photography Commands
Na diaľkovú podporu snímania na mieste môžete použiť príkazy, ako sú „Nastavenie teploty farieb pri vyvážení bielej
farby“ a „Príkaz zákazu snímania“.

TP1002070788
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Aktivácia každej licencovanej funkcie

Ak chcete aktivovať každú licencovanú funkciu, musíte načítať licenčný súbor uložený na pamäťovej karte do
fotoaparátu.

Podrobnosti o príslušných úkonoch nájdete v nasledujúcej časti „Príručka“.
https://helpguide.sony.net/di/activate/v1/sk/index.html

TP1002070789
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Používateľská pomocná mriežka

Zaregistrovať a používať môžete svoju vlastnú používateľskú pomocnú mriežku vytvorenú tak, aby vyhovovala vašim
konkrétnym potrebám vo fotoaparáte. Navyše pomocou „Custom Gridline Generator“ môžete nastaviť oblasti orezania na
pomocnej mriežke a priamo zaregistrovať vytvorenú pomocnú mriežku vo fotoaparáte.

Ďalšie informácie nájdete v nasledujúcej časti „Príručka“.
https://helpguide.sony.net/di/gridline_2420/v1/h_zz/

TP1002070793
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Nasnímanie a zaregistrovanie čiarového kódu alebo QR kódu pomocou fotoaparátu

Prostredníctvom fotoaparátu môžete načítať kód s informáciami o objekte vložené ako jedinečný identifikátor. Daný
jedinečný identifikátor sa zaregistruje vo fotoaparáte a môže sa zapísať do metaúdajov zachyteného záberu. Táto
funkcia dokáže načítať čiarové kódy a QR kódy ITF/Code39/Code128.

Táto funkcia poskytuje dva spôsoby snímania kódov pomocou tohto fotoaparátu.

Code Scan during hold
Túto funkciu je potrebné priradiť používateľskému tlačidlu, ktoré sa má používať. Fotoaparát sa prepne na obrazovku
snímania kódu počas stlačenia priradeného tlačidla a vráti sa na obrazovku snímania po uvoľnení tohto tlačidla.
Počas držania fotoaparátu môžete rýchlo prepínať medzi snímaním kódov a snímaním fotografií.

Code Scan
Ak túto funkciu priradíte používateľskému tlačidlu, po každom stlačení priradeného tlačidla sa bude obrazovka
prepínať medzi obrazovkou snímania kódov a obrazovkou snímania záberov. Tento spôsob je užitočný, keď chcete
osobitne snímať kódy a zábery, keďže nemusíte neustále držať stlačené priradené tlačidlo.

[Code Scan] je možné zvoliť v MENU a môže sa aj zaregistrovať do ponuky Fn v [Fn Menu Settings].

MENU → [Setup] → [Operation Customize] → [Custom Key/Dial Set.] → Priraďte [Code Scan during hold]
alebo [Code Scan] požadovanému tlačidlu.

1

Prepnite na obrazovku snímania kódov.

Ak sa používa [Code Scan during hold]: Podržte stlačené tlačidlo, ktorému sa priradila daná funkcia, a to
dovtedy, kým sa nedokončí snímanie kódov.
Ak sa používa [Code Scan]: Raz stlačte tlačidlo, ktorému sa priradila daná funkcia.

2

Kód, ktorý chcete nasnímať, uchovávajte v zornom poli.

Po úspešnom nasnímaní kódu sa ozve zvukový signál a v spodnej časti obrazovky sa zobrazí zaregistrovaný
jedinečný identifikátor oranžovej farby.

Ak snímanie kódu zlyhá, skúste nasledovné:

Uistite sa, že sa kód objaví v maximálnej veľkosti v strede zorného uhla. Ako všeobecné pravidlo platí, že
veľkosť QR kódu by mala byť minimálne 1/3 výšky celého zorného poľa a veľkosť čiarového kódu minimálne
1/3 šírky zorného poľa.
Skontrolujte minimálnu vzdialenosť snímania vášho objektívu a umiestnite kód ďalej, než je táto vzdialenosť.
Zo zorného poľa odstráňte objekty s vysokým kontrastom.
QR kódy sa pri malých rozmeroch snímajú ľahšie než čiarové kódy.

3
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Spôsob registrácie jedinečného identifikátora nasnímaného bežne dostupnou čítačkou
kódov vo fotoaparáte
Je potrebné použiť Camera Remote SDK (súprava na vývoj softvéru).
Ďalšie informácie o Camera Remote SDK (súprava na vývoj softvéru) nájdete na nasledujúcej webovej stránke.
https://support.d-imaging.sony.co.jp/app/sdk/en/index.html

Informácie o zápise jedinečných identifikátorov do metaúdajov záberu

Naraz možno zaregistrovať až dva jedinečné identifikátory. Ak chcete zaregistrovať druhý jedinečný identifikátor,
stačí umiestniť ďalší kód do zorného poľa ešte pred nasnímaním obrázka. Po úspešnom nasnímaní sa obidva
identifikátory zobrazia vzájomne nad sebou. Horný je prvý jedinečný identifikátor a dolný je druhý jedinečný
identifikátor.

Prepnutím sa vráťte na obrazovku snímania.

Ak sa používa [Code Scan during hold]: Uvoľnite tlačidlo, ktorému sa priradila daná funkcia.
Ak sa používa [Code Scan]: Raz stlačte tlačidlo, ktorému sa priradila daná funkcia.

Po zatvorení obrazovky snímania kódov sa farba zaregistrovaného jedinečného identifikátora zmení na bielu.
Fotoaparát môžete tiež prepnúť späť na obrazovku snímania kódov s cieľom zaregistrovať druhý jedinečný
identifikátor. V tomto prípade sa prvý jedinečný identifikátor zobrazí bielou farbou v hornom riadku a druhý
jedinečný identifikátor sa zobrazí oranžovou farbou v spodnom riadku.

4

Nasnímajte objekt.

Daný jedinečný identifikátor sa zapíše do metaúdajov zachyteného záberu.

Ak sa zaregistrujú dva jedinečné identifikátory, oba sa zapíšu do metaúdajov jedného záberu.

5

Prepnite fotoaparát späť na obrazovku snímania kódov a uchovajte kód v rámci zorného poľa.

Jedinečný identifikátor sa nahradí novým identifikátorom.

Ak nasnímate záber so zaregistrovaným jedinečným identifikátorom a potom znova nasnímate kód, jedinečný
identifikátor sa vymaže a nahradí novým identifikátorom.

6

Pripojte fotoaparát k počítaču a aktivujte funkciu diaľkového snímania.

Spôsob pripojenia a nastavenia funkcie diaľkového snímania sa líšia v závislosti od používaného fotoaparátu.

1.

Pripojte čítačku kódov k počítaču.2.
Pomocou čítačky kódov nasnímajte čiarový kód alebo QR kód.3.
Nasnímaný jedinečný identifikátor odošlite z počítača do fotoaparátu pomocou SDK.4.
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Jedinečný identifikátor sa zapíše do metaúdajov záberu podľa nasledujúcich špecifikácií.

Oblasť Exif IFD: MakerNote IFD*

Č. značky Exif: 0x2043
Veľkosť údajov: maximálne 128 znakov/maximálne 256 bajtov
Formát údajov: UTF-16LE (Little Endian)

Keď sa zapíšu dva jedinečné identifikátory do metaúdajov, medzi dva jedinečné identifikátory sa vloží „,“ (čiarka).
Po zápise jedinečného identifikátora do záberu sa pomocou fotoaparátu nebude dať zmeniť. Na získanie prístupu do
oblasti Exif MakerNote (oblasť konkrétneho výrobcu) a načítanie alebo úpravu daných informácií bude potrebné
pripraviť svoj vlastný systém alebo svoju vlastnú aplikáciu.
Jedinečný identifikátor v oblasti MakerNote je zakódovaný v UTF-16LE. Ak chcete získať rovnaký reťazec ako pri
nasnímaní kódu, budete musieť premeniť znakový kód.

Rada

Ak má jedinečný identifikátor príliš veľa znakov, môže sa skrátiť na „...“, keď sa zobrazí na obrazovke snímania kódov alebo
obrazovke snímania záberov. V tomto prípade môžete skontrolovať všetky znaky v MENU → [Shooting] → [File] → [Scan and
Tag] → [Unique ID Details Info.].

Keď sa zaregistrujú dva jedinečné identifikátory a nasníma sa tretí kód, prvý jedinečný identifikátor zobrazený v hornom riadku
zmizne, druhý jedinečný identifikátor sa posunie na horný riadok a tretí jedinečný identifikátor sa pridá na spodný riadok.

Poznámka

Aj keď opakovane nasnímate rovnaký jedinečný identifikátor, daný jedinečný identifikátor zaregistrovaný vo fotoaparáte sa
nezmení.

Keď sa režim zaostrovania pre snímanie nastaví na automatické zaostrovanie, režim zaostrovania sa na obrazovke snímania
kódov uzamkne na AF-C (Continuous AF).

Keď sa režim zaostrovania pre snímanie nastaví na manuálne zaostrovanie, aj režim zaostrovania na obrazovke snímania kódov
sa uzamkne na manuálny režim. Zaostriť na kód budete musieť sami.

Ak snímanie kódu zlyhá, ozve sa signál odlišný od signálu v prípade úspešného nasnímania. Skontrolujte chybové hlásenie
zobrazené na monitore.

Po vypnutí fotoaparátu sa jedinečný identifikátor resetuje.

Maximálna dĺžka jedinečného identifikátora je 128 znakov. Ak zaregistrujete dva jedinečné identifikátory, maximálne dĺžka
každého z nich bude 63 znakov.

Jedinečný identifikátor obsahuje nižšie uvedené alfanumerické znaky a symboly. „,“ (čiarka) sa nedá použiť.
. - _ ' @ ! ? # $ % & * + / = ^ ` { | } ~ " ( ) : ; <> [ \ ] medzera

TP1002070790
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V závislosti od používanej aplikácie sa môžu informácie o MakerNote vymazať.*
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Zobrazenie jedinečných identifikátorov na obrazovke

Môžete nastaviť to, či sa bude alebo nebude zobrazovať zaregistrovaný jedinečný identifikátor na obrazovke snímania.

Podrobnosti položky ponuky
On:
Jedinečný identifikátor sa bude zobrazovať na obrazovke snímania.
Off:
Jedinečný identifikátor sa na obrazovke snímania nebude zobrazovať.

Spôsob zobrazenia jedinečného identifikátora na obrazovke prehrávania
To, či sa jedinečný identifikátor na obrazovke prehrávania zobrazí alebo nie, závisí od režimu zobrazenia obrazovky.
Keď je režim zobrazenie obrazovky [Histogram] alebo [No Disp. Info.], jedinečný identifikátor sa nezobrazí. V tomto
prípade stlačením tlačidla DISP (Nastavenie zobrazenia) prepnite režim zobrazenia obrazovky.
Ak chcete počas prehliadania záberov zachytených pri nepretržitom snímaní zobraziť jedinečný identifikátor, nastavte
[Playback] → [Playback Option] → [Display as Group] na možnosť [Off].

Rada
Ak priradíte [Unique ID Display] požadovanému tlačidlu v MENU → [Setup] → [Operation Customize] → [Custom Key/Dial Set.],
budete môcť zapnúť alebo vypnúť zobrazenie jedinečného identifikátora jednoducho stlačením priradeného tlačidla.

Ak má jedinečný identifikátor príliš veľa znakov, môže sa skrátiť na „...“, keď sa zobrazí na obrazovke snímania kódov alebo
obrazovke snímania záberov. V tomto prípade môžete skontrolovať všetky znaky v MENU → [Shooting] → [File] → [Scan and
Tag] → [Unique ID Details Info.].

Poznámka
Na obrazovke snímania sa jedinečný identifikátor zobrazí s prioritou oproti ostatným informáciám. Ak chcete vidieť informácie,
ktoré skrýva jedinečný identifikátor, nastavte [Unique ID Display] na možnosť [Off].

TP1002070791
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MENU → [Shooting] → [File] → [Scan and Tag] → [Unique ID Display] → požadované nastavenie.

Východiskové nastavenie je [On].

1
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Kontrola informácií o jedinečnom identifikátore

Umožňuje skontrolovať všetky znaky jedinečných identifikátorov zaregistrovaných vo fotoaparáte.

Rada
Jedinečné identifikátory sa zobrazia v prírastkoch po 4 znakoch. Ak jedinečný identifikátor začína štyrmi písmenami „http“,
rozpozná sa ako adresa URL a zobrazí sa ako jeden celok.

Ak sa zaregistrujú dva jedinečné identifikátory, zobrazia sa vzájomne nad a pod sebou. Prvý jedinečný identifikátor sa zobrazí ako
[ID1:] a druhý jedinečný identifikátor sa zobrazí ako [ID2:].

TP1002070798
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Zaregistrujte jedinečný identifikátor vo fotoaparáte.1

MENU → [Shooting] → [File] → [Scan and Tag] → [Unique ID Details Info.].

Ak vopred priradíte túto funkciu požadovanému tlačidlu pomocou [Custom Key/Dial Set.], budete môcť rýchlo
skontrolovať podrobné informácie o jedinečných identifikátoroch jednoducho stlačením priradeného tlačidla na
obrazovke snímania.
Túto funkciu môžete zaregistrovať aj v ponuke Fn v položke [Fn Menu Settings].

2
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Vymazanie jedinečného identifikátora z fotoaparátu

Jedinečný identifikátor, ktorý sa zaregistroval nesprávne alebo ktorý už nechcete používať, môžete vymazať.

Rada
Ak priradíte [Reset Unique ID] požadovanému tlačidlu v MENU → [Setup] → [Operation Customize] → [Custom Key/Dial Set.],
budete môcť resetovať registráciu jedinečného identifikátora jednoducho stlačením priradeného tlačidla.

Poznámka

Po vypnutí fotoaparátu sa jedinečný identifikátor resetuje.

Ak sú zaregistrované dva jedinečné identifikátory, vymažú sa obe registrácie.

TP1002070792
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MENU → [Shooting] → [File] → [Scan and Tag] → [Reset Unique ID].1

Zvoľte [OK] a stlačte stred.

Registrácia jedinečného identifikátora sa resetuje.

2
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Photo Cropping

Súčasne môžete pri snímaní ukladať orezané zábery pomocou pomocnej mriežky s vopred zadefinovanou oblasťou
orezania.
Aby bolo možné aktivovať [Photo Cropping], všetky nasledujúce podmienky musia byť splnené:

Oblasť orezania je nastavená na pomocnej mriežke.
Pomocná mriežka je zaregistrovaná v niektorom z nastavení  (Custom 1) až  (Custom 4).
MENU → [Shooting] → [Shooting Display] → [Photo Cropping] je nastavené na možnosť [On].
MENU → [Shooting] → [Shooting Display] → [Grid Line Display] je nastavené na možnosť [On].

Aby ste mohli použiť túto funkciu, pre používateľskú funkciu pomocnej mriežky musíte mať aj licenciu. Ďalšie informácie
o používateľskej funkcii pomocnej mriežky a spôsobe nastavenia oblastí orezania na pomocnej mriežke nájdete
v nasledujúcej časti „Príručka“.
https://helpguide.sony.net/di/gridline_2420/v1/h_zz/

Rada

Orezané zábery budú na obrazovke prehrávania označené ikonou  (Crop).

Poznámka

Ak sa aktivuje funkcia [Photo Cropping], nasledujúce funkcie sa nebudú dať použiť.
Automatická kontrola záberov
Nepretržité snímanie

Funkcia [Photo Cropping] sa nedá použiť v nasledujúcich situáciách:
Keď sa režim činnosti nastaví na inú položku ako [Single Shooting]
Keď je [File Format] nastavený na [RAW]

Uložte pomocnú mriežku s oblasťou orezania na pamäťovú kartu a vložte ju do fotoaparátu.1

MENU → [Shooting] → [Shooting Display] → [Grid Line Type] → Zvoľte cieľové miesto registrácie v 
(Custom 1) až  (Custom 4) a potom zvoľte [Import].

2

Zvoľte pomocnú mriežku s oblasťou orezania, stlačte stred a zvoľte [OK].

Pomocná mriežka sa zaregistruje ako používateľská pomocná mriežka.

3

MENU → [Shooting] → [Shooting Display] → [Grid Line Display] → [On].4

MENU → [Shooting] → [Shooting Display] → [Photo Cropping] → [On].

Na obrazovke sa objaví ikona ( ), čo znamená, že sa aktivovala funkcia [Photo Cropping].

5

Nasnímajte objekt.

Uložia sa pôvodný záber a orezaný záber.

6
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Počas intervalového snímania
Počas kompozitného snímania formátu RAW
Počas vykonávania [Recall Custom hold 1]/[Recall Custom hold 2]/[Recall Custom hold 3]

Aj keď sa funkcia [Photo Cropping] aktivuje, oblasť orezania sa na obrazovke snímania nezobrazí. Ak chcete počas snímania
kontrolovať oblasť orezania, vo svojej používateľskej pomocnej mriežke nakreslite pomocnú mriežku s rovnakou polohou a
veľkosťou, ako je oblasť orezania.

Počas prehliadania sa orezané zábery s iným zobrazovacím pomerom, ako je zobrazovací pomer dostupný vo fotoaparáte
nedajú zväčšiť.

Orezané zábery sa nedajú orezať.

Pri zobrazení orezaného záberu sa pomocná mriežka nezobrazuje.

Ak sa pri diaľkovom snímaní nastaví [Still Img. Save Dest.] na [Destination Only] alebo [Dest.+Camera], orezaný záber sa
neprenesie; prenesie sa len pôvodný záber.

Medzi orezanými oblasťami vytvorenými pomocou funkcie „Custom Gridline Generator“ a skutočnými polohami orezania môže
byť maximálna odchýlka 15 pixelov.

Ak má fotoaparát dva otvory na pamäťovú kartu, otvor, v ktorom je pamäťová karta, na ktorú sa orezaný záber uloží, sa určí na
základe nastavení fotoaparátu.

Ak sa [Recording Media] nastaví na [Simult. Recording], orezaný záber sa uloží na pamäťovú kartu v otvore nastavenom
v [Play Set of Multi. Media].
Ak sa [Recording Media] nastaví na [Sort Recording] a [File Format] sa nastaví na [RAW & JPEG] alebo [RAW & HEIF],
orezaný záber sa uloží na pamäťovú kartu v otvore, v ktorom sa zaznamenávajú zábery vo formáte JPEG alebo HEIF. V tomto
prípade sa [Play Set of Multi. Media] nastaví na otvor, v ktorom sa na pamäťovú kartu uloží orezaný záber.
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Príručka

Funkcie kompatibilné s licenciou pre hromadné fotografovanie

Volume Photography Commands

Táto funkcia poskytuje príkazy na rozšírenie diaľkového ovládania. Rozšírené príkazy poskytnuté na základe tejto
licencie je možné použiť v aplikáciách vyvinutých pomocou „Camera Remote SDK (súprava na vývoj softvéru)“.
Ďalšie informácie o Camera Remote SDK (súprava na vývoj softvéru) nájdete na nasledujúcej webovej stránke.
https://support.d-imaging.sony.co.jp/app/sdk/en/index.html

Nastavenie teploty farieb pri vyvážení bielej farby

Teplotu farieb pri vyvážení bielej farby je možné presne nastaviť v prírastkoch po 10 K prostredníctvom diaľkového
ovládania.

Poznámka
Tento príkaz je určený len na diaľkové ovládanie a nedá sa vykonať na samotnom fotoaparáte.

Teplota farieb sa nastavuje vo fotoaparáte v prírastkoch po 100 K, takže akákoľvek hodnota nastavená v 10 K prírastkoch
prostredníctvom diaľkového ovládania sa prepíše na hodnotu v 100 K prírastkoch, keď sa teplota farieb zmení v samotnom
fotoaparáte. Ak chcete nastaviť hodnotu v 10 K prírastkoch, znova vykonajte daný úkon pomocou diaľkového ovládania.

Príkaz zákazu snímania

Táto funkcia umožňuje diaľkový zákaz fotoaparátu snímať. Podmienky, za ktorých bude snímanie zakázané, je možné
ľubovoľne nastaviť prostredníctvom naprogramovania, ktorým sa zabráni fotografovaniu v neočakávanom prostredí.
Keď je snímanie zakázané, na obrazovke snímania sa po stlačení tlačidla spúšte zobrazí hlásenie. Na fotoaparátoch
s touto funkciou bude zakázaná aj funkcia [Pre-Capture].

Poznámka
Tento príkaz je určený len na diaľkové ovládanie a nedá sa vykonať na samotnom fotoaparáte.

Nastavenie zákazu snímania sa zruší, keď sa fotoaparát vypne, ale nezruší sa, ak sa fotoaparát vypne automaticky kvôli úspore
energie alebo z iných dôvodov.
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